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Before using this information, be sure to read the general information under the “Notices” section
on page 37.

This edition applies to VERSION 4.0, Rational Dashboard and to all subsequent releases and
modifications until otherwise indicated in new editions.

© Copyright 2004, 2009

U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted by GSA ADP
Schedule Contract with IBM Corp.
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Welcome
Welcome to the Change Walkthrough for IBM Rational Dashboard!

IBM Rational Dashboard brings software management best practices within reach of every
organization and every manager. Manage requirements, schedule, budget, quality, configuration
management and size in one place; keeping total control of the drivers that keep projects on time
and within budget.

IBM Rational Dashboard spans the gap between the management process desired and the one
currently in place. Focus on managing by exception using IBM Rational Dashboard alerts,
analysis, graphical displays and drillable views that provide all the information needed to make
well-informed decisions quickly. Using a web-based interface and intelligent integrations to
software life cycle tools, IBM Rational Dashboard delivers industry best practices ready to be
applied. Finally, IBM Rational Dashboard checks project compliance with industry standards and
unit templates, ensuring a course to success.
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Data Collection Overview

Before beginning the integration to a data source, it is important to understand the key elements
that allow the portal to gather and display data from your data.

Data in the Portal is gathered by the Collector, configured by the Interfaces, organized by
Information Needs and analyzed in the Organization Tree.

Collector Interface
—p

A

Organization Tree

Library —» Information Need

The Collector (Windows based executable) - Gathers data from outside sources and stores it in
the Transform database.

e Outside Data Sources include: IBM Rational DOORS, IBM Rational Synergy, IBM Rational
Change, IBM Rational ClearQuest, Microsoft Project, Oracle Databases, Microsoft SQL
Databases, Microsoft Access, Microsoft Excel, ODBC, CSV, and HP Quality Center.

e The Transform is a Microsoft SQL Database table located in the Dashboard_Transform
database. It stores current and historical data collected from Outside Data Sources.

Interfaces (From the Collection tab in the Portal) - Allow users to define and organize data
collected by the Collector. Interfaces are defined using three subtabs: General, Fields and
Queries.

e The General tab includes the type of data being retrieved from the Outside Sources as
well as the name of the database that will be used to store the data.

e The Fields tab defines the field sets of data that are being retrieved as well as the table
name where information will be stored in the Transform.

e The Queries tab indicates the SQL queries that will be run against the Transform to
produce data points for Graphs.

Information Needs (From the Library tab in the Portal) - Allow users to define graphs to display
the collected data.

e Graphs contain Series that are used to plot data against time/events.
e Series are associated with Queries defined in Interfaces to determine which data to plot.
e Information Needs can be used by one or more interfaces.

Organization Tree (From the Status tab in the Portal) — Allows users to display and analyze data
in Graphs which are defined in Information Needs.

e Folders and Units provide structure for the Organization Tree.
e Units can contain one or more Information Needs.
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IBM Rational Change Sample Walkthrough

This sample describes the steps to be performed in tool needed to configure and collect data from
IBM Rational Change. This sample walks a new user through all required steps needed to see
graphs with data points populated with information from IBM Rational Change.

There are three areas that will be covered through this walkthrough:
e Portal Configuration:

o Examine/Configure an Interface in the Portal

o Examine/Configure an Information Need

o Assigning Schedules to a Template

o Setup a Unit with Information Needs (or use a template)
e Collector Configuration

o Configure the Collector

o Run a collection

o Check/Resolve any collection errors/problems
e Unit Configuration

o Check for collected items in the Portal and assign them to Units

o Refresh the Unit

o View collected data graphs in the Portal
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Configuring the Portal

The Portal provides the user the ability to describe which data to collect, how to analyze it and
then how to display it. Before information can be analyzed or displayed, the Portal must be
configured to collect the information from IBM Rational Change.

Verifying the Interface in the Portal

Upon opening the application, the Portal defaults to the Status page. The first step is to verify the
Interface. Select the Collection tab, and then click on the Interfaces option on the left hand

side.

Collection

|

C
Collectors

Interfaces
Interface Types

Interfaces

Add Add a new interface.

[ Edit ] [ Delete ] DOORS Requirements 1EM Rational DOORS
[ Edit ] [ Delete ] IEM Rational Change IEM Rational Change
[ Edit ] [ Delete ] IEM Rational Synergy 1IBM Rational Synergy

Generate SQL schema for datamart.

From the Interfaces List, click on the edit button to open the IBM Rational Change interface.
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The interface will open in the general tab. This is where all the information about what is being
collected is stored. This specific interface is a default interface for IBM Rational Change. You will

notice that a short description has been entered and the Transform Server has been selected as

the Database.

Edit Interface Collection - Edit Inferface (IBM Rational Change)
general | fields | queries |
Name: IBM Rational Change
Interface Type: IBM Rational Change
Description: Change tracking at organizational level T

Type Wdentifier:

Database: Transform Database -

Copy: Copy field 2ets and queries from the interface selected below into this one.
Mote: All field sets and gueries in this interface will be deleted.

no selection -

Copy Field Sets and Queries

(4

Save I I Cancel [¥] add (new) table fields during save?

Update or delete table fields during save?

Next, click on the fields tab.
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Setting up the Fields

The information entered in the fields tab of the Interface defines the information that will be

collected and where it will be stored. The list of sets (each containing a group of fields) and the

database where the information will be stored is located on the left section of the screen. A list of

default fields, which are being collected by the Portal, is located on the right hand section of the
screen. The list of fields displayed changes based on the set selected from the List of Sets drop

down menu. These fields are the default values that all of the graphs will use to display the data.

Edit Interface
List of Sets:
Default Set
Add
Title: Default Set

Database Table: SynergyChange

[ =] Parameter Replacement Tag:

Apply ” Delete

Save ] [ Cancel

Collection -> Edit Interface (IBM Rational Change)

Fields in Selected Set:

ayname - displa
release - release (text 50)
crstatus - crstatus (text 50)
request_type - request_type (text 50)
priority - priority (text 50)
severity - severity (text 50) -

m|»

Selected Field Properties
[7] Do not collect from source?
Source Atfribute:  displayname
Changes below modify the associated database table. Changes of: 1) string

type te non-string; 2) string to shorter string; or 3) allew null to not allew null;

will result in the field being dropped and re-added causing loss of data.
Table Field:
Type: Text 50 v
Value: =
@ Allow null - default optional default value:

[ ! Don't allow null - default required

Apply ] ’ Delete

Add (new) table fields during save?

Update or delete table fields during save?

Next, click on the queries tab.
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Modifying the Data Queries

The Query tab will list all of the queries assigned to the Interface. These queries are used to

count and quantify the data that is collected.

Add a new single series query to this interface ...

Collection -= Edit Interface (IBM Rational Change)

Edit Interface
| general | fields | queries |
Cueries: Add
Add

Add a new multiple series query to this interface ...

[ Select Series ] Az=ign these queries to zeries in the Library ...

I e 7N

[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

Edit || Delete |Alocsted Defects by Severty
Edit || Delete | Cosed Defects

Edit ] [ Delete ] Days in Phase

Edit || Delete |psfectond

Edit ] [ Delete ] Defects Injected

Edit || Delete |Effort per Subsystem

Edit || Delete |EapsedDaysinphase

Edit || Delete |estmated Effort Medium
Edit ] [ Delete ] Estimated Effort Minor

Edit || Delete |Estmsted Effort Severe

Edit ] [ Delete ] Estimated Effort Showstopper
Edit ] [ Delete ] Estimated Hours for Open Defects
Edit ] [ Delete ] Estimated Hours for Open ERs
Edit || Delete |newcrs

Edit || Delete | New Defect Medium

MultipleSeries
SingleSeries
SingleSerizs
SingleSeries
MultipleSeries
MultipleSeries
SingleSerizs
SingleSeries
SingleSeries
SingleSeries
SingleSerizs
SingleSeries
SingleSeries
SingleSeries

SingleSerizs

Clicking the edit button, for a query in the main list, will open the Edit Query page and allow the
user to edit the selected query.
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Below is the Edit Query page for Closed Defects. There are two options available when
modifying a query: Query Builder and Query Edit.

Edit Query Collection -= Edit Interface (IBM Rational Change) -= Edit Query

Title: Closed Defects (27}

Select Series Asz=ign these gueries to series in the Library ...

Cluen Builder | Cluery Edit | Test CQuerny |

1 Data from: SynergyChange database table
2 Result is: @ a count of i© asumof |displayname (Default Set)
3 Filters are: the current item for the current period

4 With terms:

request_type = Defect’
crstatus IMN (% A(Synergy Status Closed)%’)

Add new query term:

displayname (Default Set) - = -

Add Start Date =

Save ][ Cancel ]

To modify this query, click on the Query Edit button.
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The Edit Query tab has a text field where the SQL statements can be entered, modified or

deleted. You can place your cursor anywhere in the text field to add or modify the query. At this

point we could modify the statement or delete a portion of the query.

Title: Closed Defects

I Select Series ‘ Ass=ign these gueries to zeries in the Library ...

Gueryp Builder Cuery Edit

Edit Query

SELECT COUNT (*) FROM ¥TRABLE%® WHEEE g itemid=3ITEMIDZ AND
g_collectdate=3COLDATEY AND request type = 'Defect' AND
IN ('"%A(Synergy Statu=s Closed)3')

Save

Edit Query Collection -> Edit Interface (IBM Rational Change) -= Edit Query

(27)

crstatus

If any changes are made to the query, be sure to save your changes.

© Copyright IBM Corp. 2004, 2009
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Verifying the Information Need

This step is optional, as no changes need to be made in the Information Need to help the Collector
run. This will allow you to familiarize yourself with the graphs that will be displaying data in the
future. To see the Information Needs, click on the Library tab of the Portal.

There are six information needs that are setup to work with IBM Rational Change automatically.
They are: Defect Productivity, Defect Quality, Defect Schedule, Enhancement Productivity,
Enhancement Quality and Enhancement Schedule.

Library
Information Need List
(551 agg newe ntormaton nees
Information Need List
Olmension Ust it | [ e 07 Feb 07 Defaut CM Appropriste Use
Unit Template List :
et _f"'-' J 07 Feb 07 Defat CM Change Rate
. EE] T oo o ——
Taloring

[I} E’ 07 Feb 07 Defaut ©M Work Qualty

[ ] [Coome ] 180206 Oefaut CHIE lavel 2 Impilammantation Status
[ ] [Coom ] 01 20 06 Oetout Cont Control
[ ] e ] 0106 Defau Defect Productvty
oo | o] 01 Jan 06 Defaut Defct Quaity
oo ] [Coome | 0t Jan 0% Dafaut Defact Schedule

[T | [Coom ] 03 2 08 Oetaut Earrad Yaiue Managermact
[ ] [Caw ] 01 30 06 Dot Erhancement Productvy
e | [[oem] 01 Jan 06 Dafat Enhancemant Quaity
[ ] 01 Jan 06 Oefact Erhancemant Schedule
[T ] [Coom ] Giindé Ot Graghrg Sarc
] IO R M

> >> |

Let’s take a look at the information need, Defect Quality. To open the information need, click on
the edit button.
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The information need will default to the general tab. The information need, Defect Quality,
contains graphs that will track the quality of the delivered software.

Information Need Library -= Information Need (Defect Quality)

general | 1eferenice I guidahce | araphs | dimenzions |

Title: Defect Quality

State: O draft @ defined O active O retired

Keywords: |gefect Mmanagement
guality management

defects.

Created on 1/1/2006  Created by Default
Updated on: 3/6/2008 [ Review and Synchronize

[ Save ] [ Cancel ] [1Set the update date to current date and time during save?

Description: |Tni= informarion need contains a series of graphs TO Manage the
guality of delivered software items by tracking submitted

{7

Selecting the graphs tab will list the graphs associated with the selected information need. In

the sample below, Defect Quality has seven graphs defined. The various graph descriptions and
series for each of the listed graphs can be edited here. When the Information Need is added to a

unit, the graphs are applied to the data.

Information Need Library -> (nformation Need (Defect Qualify)

| general | 1eference | guidance | graphsz

Defect Arrival Rate'\Total New

Current Actual:

Current Plan: Defect Arrival Rate\Planned Defects
Current Status: Defect Arrival Rate\Showstapper Alarm

T graphs defined

Graphs: Edit ][ Delete ][ Add Add new graph

Defect Arrival Rate (Run)

Defects By Phase Injected (VerticalBar)
Mew Defects (VerticalBar)

Open Defect Age- Severe (Run)

Open Defect Age- Showstopper (Run)
Open Defects (VerticalBar)

Open Reported Defects (Run)

[ Save ] [ Cancel ] []Set the update date to current date and time during save?

© Copyright IBM Corp. 2004, 2009

13



Assigning Interface Queries to a Library Series

To enable data to be populated in a series, each series must have one or more interface queries
associated with it. Once a query is associated with a series, the query is run after data collection
to provide a data point for the series. Because a graph in the library is not specific to one
interface (that is, a graph may have more than one interface that can provide data for it), you
may select multiple interface queries for one series. So, you may assign a query from more than
one interface to the same series in the Library. When the graph (that contains the series) is
created in a Unit, the associated interface query is used.

For series with a data source of single-series or multi-series, you will see the number of Interface
queries that have been assigned, and you can click on the “Select Queries” button to assign
queries. If the Select Queries button is not enabled, make sure the source is single-series or
multi-series (as appropriate) and then press the Save button. To simplify the process, the Portal
provides you with the ability to either 1) assign series to queries or 2) assign queries to series.
You can access this from either the Library Graph page (see next image) or the queries sub-tab in
the Edit Interface page.

Library Graph Library -> Information Need (Defect Quality) -> Graph (Defect Amval Rate)
TETiEE
[ Add || Delete |
MultiSeries Holder (actual data) Title- Total New (80)
Planned Defects (plan data) ) i ) i
Severe Alarm (alarm) Type: 2 Alarm @ Data ) Region 0 Text
Showstopper Alarm (alarm - - 2 2
Duration: @ ) 5]
Total Novw (actusl data ura_ ion @ Actual 2 Plan _ Forecast
Use: @ Normal ) Primary X/Status Value © Primary Y
[[Ils hidden? Order: 1 -
Source: © manual
@ single series query |Select Queries | 1 queries have been assigned to this series.
O multi-series query
(@) equation
Sample Data: diagonal up = End value 100

Save ][ Cancel
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The Assign Series to Queries page allows you to assign one of more queries to a series in the
Library. This page has two sub-tabs described below. Once you are done with the assignment,
use the breadcrumbs at the top of the page to return to previous page.

On the “to query” sub-tab, you may select a series from the Library (select an information need
and then a graph/series from the drop downs) and then review a list of Interface queries, if any,
that have been assigned to the series. You may select an interface from the (lower) dropdown,
and then assign one of the Interface queries to the currently selected series. This sub-tab is

designed to review all the interfaces that a single series has been assigned to.

Assign Series To Queries

Information Need:

Series:

Assigned Queries:

Interface Queries:

Library -= Information Need (Defect Quality) -= Graph (Defect Amval Rate) -> Assign Series To Query

Defect Quality -
Defect Arrival Rate\Total New -

This =eries has been assigned to 1 interfaces.
Interface

IBM Rational Change

Query
Mew Defects

Unassign

Select an Interface then press "Assign” to indicate a query can provide data for this series.
IBM Rational Change -
Query

Assign | Allocated Defects by Severity
Assign | Clossd Defects
Assign | Days in Phase
Assign | Defect Grid
Assign | Defects Injected

Assign Effort per Subsystem
Assign Elapsed Days in Phase
Assign Estimated Effort Medium
Assign | Estimated Effort Minor

Estimated Effort Severe

Assign

Edit Query
Edit Query
Edit Query
Edit Query
Edit Query
Edit Query
Edit Query
Edit Query
Edit Query
Edit Query

© Copyright IBM Corp. 2004, 2009
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On the “to series” sub-tab, you may select an information need and interface and then assign or
un-assign the series to queries as needed. This sub-tab is designed to help assign all the queries
in an interface at one time to the series in one information need. Below, the "New Defects” query
from the IBM Rational Change interface has been assigned to the “Total New” series. Notice that
the button on the appropriate column (below) now says “Unassign” indicating that has already

been assigned.

to zenies

Infarmation Needs:
Defect Quality
Series

no selection

no selection

no selection

no selection

Defects By Phase Iniected\MultiSeries Holder
no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

no selection

Defact Arrival Rate'\Total New

Defect Arrival Rate\MultiSeries Holder

IBEM Rational Change

Query
Alocated Defects by Severity

Closed Defects

Days in Phase

Defect Grid

Defects Injected

Effort per Subsystem

Elapsed Days in Phaze
Estimated Effort Medium
Estimated Effort Minor
Estimated Effort Severe
Estimated Effort Showstopper
Estimated Hours for Open Defects
Estimated Hours for Open ERs
MNew CRs

New Defect Medium

New Defect Minor

New Defect Severe

New Defect Showstopper
New Defects

New Defects by Severity

Assign Queries To Series Library -= Information Need (Defect Quality) -> Graph (Defect Ammval Rate) -> Assign Query To Series

Assign
Assign
Assign
Assign
Unassign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign
Assign

Unassign

eEeRgr e

I Unassign J

When you have finished assigning queries to a series, or reviewing them, you use the breadcrumb

to return to the previous page.

© Copyright IBM Corp. 2004, 2009
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Assign a Schedule to a Change Template

This is an optional step that is not required in the setup process. To assign a schedule to a unit
when using a template, it is necessary to add a schedule to the template before creating a unit
using the template. If a schedule is not included in the template, the unit schedule will default to
a monthly schedule.

To include a schedule in a template, go to the Library tab. Select the Unit Template List from
the Library section on the left hand side of the page. This will open a list of templates currently
available for use.

Library
Unit Template List
Information Need Ust crested en creaned by Gt
Derermon Lt [ pos dolate | 01 Jan 26 Owfat CMM] Template
Ut Template List FEa J—
[ e deete | 01 Jo= 04 Dot DOCRS Template
E o] Mans | ouma G s B Tl
Tadoong 4= e
D | doee | 01 Jan % Defat Reaae Project Tempiane
"t doure | 01 2an 0% Defact Sampls Unk Template
[ it delete | 01 Jan &6 Oefatt Scltware Project Template
[ ot | dee | 0t Jen 06 Defaut IBM Rational Change Template
[ et [ deets | 07 Feb &7 Defaut IBM Rational Synergy Template

Select the edit button beside IBM Rational Change Template. Selecting the elements subtab
opens the page displaying the elements that have been assigned to the template.

Uit Tamplane Libany - Linat Tarmalade (1BM Rational Change Template)
[prmal | elemerts

acid datetn

Emmanty Tigie:

Defiact Productntly (infanesd) Tyee:  Information Need -
Dufact Quality (mfonesd) . .
Dafiact Schedule nfonaed) |
Enkancemaent Productisty {infonsad)
Enhncemant Quality {indonesd)
Enfsncament Sehedule nfsnssd)
Syrwegy Rolease (attribute)

Symeeqgy Status Closed (aitnbute)
Syresgy Status Open (atbribule)

= o
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Select the add button and enter the Title. Select Default Schedule from the drop down list for

the Type field and select the desired schedule from the Schedule drop down list.

Unit Template Library -= Unit Template (1BM Rational Change Template)

general elements

| Add | Delete |

Elements:

Title: | Weekly Schedule

Defect Productivity (infoneed)

Defect Quality (infoneed)

Defect Schedule (infoneed)
Enhancement Productivity (infoneed)
Enhancement Quality (infoneed)
Enhancement Schedule (infoneed
Synergy Release (attribute)
Synergy Status Closed (attribute)
Synergy Status Open (attribute)

[ Save ][ Cancel ]

Type: | Default Schedule

Schedule:

Weekly Schedule 2008

-2010

Make sure to save your changes.

© Copyright IBM Corp. 2004, 2009
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Setup a unit with the IBM Rational Change Template

Once everything is set up correctly for the collection, the next step is to configure the Status tab
to show the data results. A unit can be created for each project to display the data results and

status for that project.

Status
L T P
=+ B-F400 Project

2] B-E300 Summary Uinit

CARS Progect

& mart Lo

L Jiava 21
+H ) Saftware Maragement Samples
- Samples Folger

@ Basic Unit Propenies
Title: Java Kit 2.1 demo
Owener(s): none 1211372007 - 121372008

T e

[#] Show summary?

[ Elemzng Siaies

To start, click on the Status tab. To add a unit, click on the edit subtab to organize the data tree
to include information on a project or projects. Create a folder, or use an existing one, and then

add a unit.

To add a unit, click the Add Unit button above the tree. On the right hand side of the screen,

enter a Title, Owner, Start Date and End date for the Unit. Select the IBM Rational Change

Template from the drop down list. In the sample below, we added a new Unit to the Samples

Folder and assigned the IBM Rational Change Template.

Status
View | Fiter | Edt [ sssian |

[ AddFolder |[  Add Unit

EHCH B-F400 Project
B[ Software Management Samples

R Samples Folder|

=] Graph Dema Unit
=] schedule CSV Unit

----- =] schedule Excel Unit

Title Change Test Unit

Cwner: | no selection hd
® hasic unit O summary unit
A basic unit contains manual, calculated and collected progress data

Template IBM Rational Change Template v
Dates Start date End date
[/ 2005 |8 (73172005 |8

[JFar demonstration only? Mote- Cannat be changed once created
Add

© Copyright IBM Corp. 2004, 2009
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After you click the add button, the new unit will appear in the Status tree.

Status
Wiew | Fiter | Edit | Assian |

=+ B-F400 Project Title: |Change Test Unit |
--|_:I Software Management Samples Reorder 4 4
EHBR Samples Folder Move:  [\B-F400 Project v [Move To Folder
E| State: Cinactive @ active O completed O suspended O demonstration
-2 Graph Demo Urit Template: |IBM Rational Change Template
=] Schedule CSV Unit Dates: Start date: End date:

----- 12l schedule Excel Unit

[1/ 172009 [ [12/31/2009 | £

[ Save ][ Delete ]

With the Portal configuration complete, you are ready to configure your Collector and collect data.

20|
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Configuring the Collector

Open the Collector using Start > Programs > IBM Rational > IBM Rational Dashboard >

Dashboard Collector.

Collection

control

oqress

Sources

add

it

version

portal links

support resources

File Collection Sources Tools Help

Control Collection

O all Sources

) One Source

Collect for:

® Today

() Specified Date ’

) From Specified Date to Today | Thursday May

Last collection:

© Copyright IBM Corp. 2004, 2009
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Verify Connection to Web Services

The Collector uses the Web Services to communicate with the Portal. To verify your connection to

the Web Services, click File, Options from the menu bar. By default the IBM Rational Dashboard
Web Services URL is set to:

http://localhost/DashboardWsS

If you are running the collection from the server that is running the Portal then “localhost” will
work fine. If you are running the collection from a machine other than the Portal server you will
need to change the “localhost” part of the URL to the name of the server running the Portal. Be
sure to click the “"Apply” button if you make any changes.

e — x|

Dazhboard URL:
Ihttp: Hlozalhozt/D azhboard
Dazhboard Web Services URL:
Ihttp: Hlozalhost/Dashboardw’S

[T Collect data for new items regardless of collection date?

[T Auto-connect to web service Lpon startup’?

—Web Service Connechion

Port: IEEI

' Usze'Windows Credential: ¢ Use Altenate Credentials

Ilzermanme;
Fazzwond:
Click. test to werify the web service connection. [f you are currently connected, the
test test will dizconnect before starting, Contact vour Dazhboard adminizstrator if pou

need the URL.
k. Apply

Click the test button to test the connection. If, after pressing the "test" button, you receive an
error or warning message, review the message and your web services configuration to correct the

problem. The web services configuration information is contained in the web.config in the Web
Services folder.
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Add a Source

Choose sources/add from the left menu. Select IBM Rational Change as the Tool, select the IBM
Rational Change interface from the drop down and enter a name for your source. (You will notice
a drop down list of Interfaces below the Tool selection. This is used for many sources to delineate
between different instances of a tool and let the Collector know which Interface to use when
collecting from a specific source.) Click the add button.

Ele Collection Sowrces Iools Help

Collection Add Source

control

Tool:
REQQreEss
lIBM Rational Change ﬂ
Sources Interface: IIBM Rational Change j
add Marme:
lIBM Rational Change Source
[r s

oo [

VETSIOnN
portal nks

2Upport resources
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The setup for IBM Rational Change requires some basic log in information as well as some Portal
specific information.

Fie Colection Sources JTools Help
L Source:
progress [IBM Rational Change Source j [ I
Tood: IBM Rational Change Licensad
Irterf ace For this source is IBM Rational Change
add COM query chient path; IIC:\Program Files\IBM\Rational\SYNERGY CM 6.4\bin\ccm.exe _I
okt Catabase path: [‘I,}app;erv‘l,ccmu:b‘l,terrelease
User name: frem_root
version Get List Query: Iu:cm refease -list -active
Get Details Query: feern query “cvtype='probler’ and release="IRELEA:
L W inchude when running o sources?
suppOrt resourCEs
_deite |

The "Path to client" is the location where IBM Rational Change is installed on the local machine.
The "Database path" is the location of the IBM Rational Change Database. The Username and
Password allows access to IBM Rational Change database.

The Get List Query will default to: ccm release -list -active. This query will return a list of
releases. This list is then used in the Get Details Query. The Get Details Query will default to:
ccm query "cvtype='problem' and release="IRELEASE!" and (request_type='Defect' or
request_type='Enhancement')" -f "ITHEFIELDS!" -nf -u -ns. The Get Details query will run the
default query for each item reported from the Get List Query. It will return defect and
enhancement information for each release that is returned in the initial query.

Be sure to save your settings by clicking the save button in the bottom left corner.
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Running a Collection

Once you've saved your configurations, you’'re ready to run your collection. Go to the control link
in the Collection section. Click the radio button for One Source and select your source from the
drop down on the right. Below the drop down, select “Specified Date” and choose the last day of
the previous month. This will allow you to see data in your graphs automatically. See the Help
files for more information about how schedules affect the Collector.

File Collection Sources Tools: Help

Collection Control Collection

control

O all sources
progress
(%) One Source jIBM Rational Change Source ;
Sources
g Collect for: O Today
3ad
() specified Date | Friday , June 01,2007 % |
edit © From Specified Date to Today | 1Mo 8y 4 June: 11,2007 j
Tools
version
portal links Last collection:

support resources

Once you've picked your source and your date, click on the start button.
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The Collection Progress page will appear and you will be able to track your collection as it runs.
You will see in the details on the bottom the number of items and containers that were found
and see how far the collection has progressed.

File Collection Sources Tools Help

Golletten
control
Summaty
Collection for:  6/1/2007 0 Total Items Collected
proaress Start time: 3:17:45 PM (Monday) ’ 1o Cothales T
Elapsed time: 00:00:02 0 Total Errors
Sources t of 1 sources have been completed
Details

Current source:  completed sources

Current set:

Done 1 Initialize collection

Done 2 Connect and authenticate to source

Done 2.1 Query for list
) - 2.2 Query portal for existing items
yersion 2.3 Query items in list For details
0 {0 Mumber completed | found
portal links 0 {0 Completed without errors | with errors
-=-- 2.3.1 Get item details
----  2.3.2 Update item data

support resources .

Done 3 Close source connection

Done 4 Update and refresh data (for all sources)

Once your collection finishes, the summary box at the top of the collector will tell you information
about the collection itself, how long the collection took, how many items were collected, how
many rows were inserted into the database tables and how many errors were encountered, if any.
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If your collection has errors, you can click on the “"View Log File” link at the bottom of the
progress page. This will open up the log file (which can also be reached under the File menu).
This log file gives you information on why a module may not have been collected. You also might
notice that the number of found items is greater than the number of items completed. This is
most likely caused by finding containers (which are folders for IBM Rational Change), and unless
there is a report of errors, everything collected correctly.

Application Logging I

Logging Ewent List

2008-03-06 09:40:10.9828 INFO frmkdain 5 Digtributive, windppz. Tools. CToolT elelogicChange. GetDetallz e from synergy flg.out, is dazhboard? ;I
2008-03-06 09:40:13.0147 INFO frbdain 5 Digtributive. frmbd ain. DoCollect Sent data for item through web services.

2008-03-06 09:40:13.0147 INFO frmbdain 5 Digtributive. frmbd ain, DoCollect Returmed from call to get details for zet Default Set

2008-03-06 09:40:12.0147 IMNFO frmbdain 5 Digtributive. frmbd ain, DoCollect Set to collect for item dashboards

2008-03-06 09:40:13.0147 INFO frmkdain 5 Distributive. frmbd ain, DoCollect Set to get details for interface set Default Set

2008-03-06 09:40:1 30610 IMFO frmkdain 5 Distributive Windppz. T ools. CToolT elelogicChange. readDelimitery alue Successfully read delimiter value
2008-03-06 09:40:1 30610 IMFO frmkdain 5 Distributive Windppz. T ools. CToolT elelogicChange. GetDetails ling friom swnerge_flg.out, iz dazshboards
2008-03-06 09:40:15 1073 INFO frmkdain 5 Distributive. frinbd ain, DoCollect Sent data for item through web services.

2008-03-06 09:40:15. 1073 INFO frmbdain 5 Distributive. frinbd ain, DoCollect Beturned from call to get details for zet Default Set

2008-03-06 03:40:15.1073 INFO frobain 5 Distributive. frmb ain. DoCollect Sef to collect for item dashboard3d

2008-03-06 09:40:15. 1073 INFO frmkdain 5 Digtributive. frinbd gin, DoCollect Set to get details for interface zet Default Set

2008-03-06 09:40:15. 1548 INFO frmkdain & Distributive Windppz. T oole. CToolT elelogicChange. readDelimitery alue Successfully read delimiter value
2008-03-06 09:40:15. 1548 INFO frmkdain & Distributive Windppz. Toole. CToolT elelogicChange. GetDetails ling friom synerge_flg.out, iz dazshboard3
2008-03-06 09:40:17 1861 INFO frmkdain & Distributive.frinbd sin. DoCollect Sent data for item through web zervices.

2008-03-06 09:40:17 1861 INFO frmkdain 5 Distributive.frinkd sin. DoCollect Beturned from call to get details for zet Default Set

2008-03-06 09:40:17 1867 INFO frmbdain 5 Distributive. frinbd ain. DoCollect Sending to tool results to Partal. [T elelogic Change Source]

2008-03-06 09:40:21 BOB0 INFO frmkdain 5 Distributive. frinbd ain. DoCollect Checking for completion,

2008-03-06 09:40:21 BOB0 INFO frmkdain & Distributive.frinbd gin. DoCollect Sending the collection summary

2008-03-06 09:40:22 0299 INFO frmkdain & Distributive.frmbdain DoCollect Successfully completed zend of collect status

2008-03-06 09:40:22 0299 INFO frmkdain 5 Distributive.frinkd sin. DoCollect Updating assigned changed itemz in portal [refresh for 3/6/2008 3:39:50.
2008-03-06 09:40:22 4674 INFO frmkdain 5 Distributive. frinbd sin. DoCollect Successfully completed update

2008-03-06 09:40:22 4674 INFO frmkdain 5 Distributive. frinbd sin. DoCollect Completed collection command.

2008-03-06 09:40:32 4051 INFO frmkdain 1 Distributive.frinbd sin. CloseEmllp Clozing web service.

7HFH-I'IH-FIF. 15-11-10 4R57 IMFN freakd Aine 1 Distribugtive froabd Aine ctor = | _hl;l
4

Clear | 1

The next step is configuring the Unit.
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Configuring the Unit

Assigning Collected Items

Once you have run your collection without errors, you are ready to add your Items to your Unit.
Go back to the Status page and click on the edit subtab. Click on the Unit that you created
earlier. On the right hand side, click on the by source subtab. From the drop down menus,
choose your Collector and the interface that you are using to collect. When you've selected those
options, click on the show button. In the list below you will see a list of all of the items that

have been collected.

Status
Wiew | Fiter | Edt | Assion |

-8 B-F400 Project
"I_J Software Management Samples
E||_:I Samples Folder

B change Test Unit

=] Graph Demo Unit
b2 Schedule CSV Unit

""" =] Schedule Excel Unit

Unit Assigned ltems

Unassign ltem

IBM Rational Change Item {placeholder item)

By Surce

Status: ®al Ounaaaigned Oazzigned Oigncred
Collector: | SERVER w |
Interface: |IBM Rational Change R |

& show ftems O show containers

Assign As MNew ] [

lgnare ltem H

1.0
dashboard1
dashboard10
dashboard2
dashboard3
dashboard4
dashboards
dashboardh
dashboard?
dashboardd
dashboardd

Assign To Existing

© Copyright IBM Corp. 2004, 2009
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Click on the items that you want to add to this unit and then click on the assign button on the

right hand side.

Status
View | Fiter | _Edt | Assion |

E-[ B-F400 Project

"I_:I Software Management Samples
EI|_:I Samples Folder

-2l Graph Dema Unit

|9 Schedule CSV Unit

----- J Schedule Excel Unit

By Source

Status: ® al O unassigned O assigned O ignored
Collector: | SERVER v|
Interface: | IBM Rational Change w |

@ show tteme O show centainers

Ignore Item ] [ Assign As MNew ] [

Assign To Existing

Unit Assigned Items:

LInassign ltem

dashboard1 (item)

1.0
dashboard1
dashboard 10
dashboard2
dashboard3
dashboardd
dashboards
dashboardf
dashboard?
dashboardf
dashboardd

On the left hand side of the page, you will see a list of items set as Assigned Items. Now all you
have to do is refresh the unit and you will see data in the graphs.

© Copyright IBM Corp. 2004, 2009
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Refreshing the Unit

While on the Status tab, click on the view subtab and select your unit from the tree on the
hand side. On the right hand side of the page, click on the Details button.

left

Siafus
view [ _mer | _edt_ | _assign_|
#-{53 B-F400 Project Basic Unit Properties
¥ Softwane Manapesant Samgies Title: Change Test Lint actve
=1 Samples Folder Crwneris): none 112008 - 1273172008
Graph Demo Linit |E [if]] = [#] Show summany?
Schedule C5Y Linit
Synengy Test Unit Defact Froductvity
Dot iy
Dofwct Seradula
Enhancement Productiy
Enharsrbmant Qusity
Enih it Sohihs
Crsiibcaed Categir Dresbhctc By
Qruality
Schedus
ard CHMI Maturdy Linl 2 Proceas & Prosont Gualy ARLEeCE
Projact Monoring & Cortnol

In the subsequent Unit Status page, you will see an empty GANTT chart with your items listed

along the side. From there, click on the Unit Properties link under the Definition section.

Unit Status Status -> Unit Slatus [Change Test Linil)
GANTT View
N
phases

EEEETN | macageditems [ [ F M1 A]M 212 1~A]s]cln]o
[ ocimton | =

Atirkntes

Information Nesds

[een Propartes

Phases

Seouity

1Lk Proogsritio
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Next, click on the refresh button in the center of the page. This will let you refresh the data for
all of the Items and their graphs over a period of time.

Unit Status Status -= Unit Status (Change Test Unit)
Unit Definition
[vews I [Change Test uni
_ State: Qlinactive @ active O completed O suspended O demonstration
Refresh Order: |[] A4 |[ Refresh ] [ Reload ]
Schedule: R .
Attributes @ bhasic scheduls mode O advanced schedule mode
Information Needs |Weekly Schedule 2008 - 2010 V|
Item Properties -
Progress Report: |Un|t Status Report "|
Phases
Security COffice Template: | Unit.ppt v|
Unit Properties Dates: Start Date: End Date:
[/ 272009 ) (220 |
Description:
URL: [+ ] Hyperink

Project Stage:

Project Plan:

Site/Location:

Customer:

Contract/Project Mo: | |

Sponsor:

Team:

Forms: [J Action ltems

[Risks

Save

On the Refresh page, you need to choose the dates for refreshing the graphs. Since you've run a
collection for only one date, you’d only need to refresh over that date. So if, for example, you ran
your collection for February 28, you would want to refresh over that date.
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In this example, the refresh runs from January 1% to March 6%, but it could be any span of dates

that include February 28%™.

Selected Unit Change Test Unit
Refresh series with measures for the follewing date range:

start: 3/30/2009 | B2
end: 3/30/2009 |G

[ Refresh ” Cancel l

- [ dem - (T ey T Jem
Refresh Status -= Unit Status (Change Test Unif] -=

Refresh Data

After you've selected your dates, click the refresh button. The Status box below will tell you
when the refresh has completed. To get back to your unit use the bread crumbs or the cancel
button. The save button will create a log file with the information in the Status box. This is

useful if there were errors during a refresh.

© Copyright IBM Corp. 2004, 2009
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View Data in the Portal

Now you‘re ready to see your data. Once you're back on the status page in your Unit, select a

managed item to view. You should see a data point in your graphs for the date that you ran the
collection.

Unit Status Status -> Unit Status (Change Test Uny)
LR Closs Rade Gragh J CRefy e
Fate Marm “© 0
% [__jea] Jewhendes) H00 -
Vo <
00 - W00
w b o ¥
8 = 2% 3
§ 21 T B 3 :
Y oo 3 B
s i s 420 4
» P . »
S0, g, o

F
F

A - T
G -EEI.L:-D «0 - noo
w 0 %00 4
o 11 1 1 1 20 \ 100 —1-
A
» w0 ‘ B & ne <
2 200 = W0
» e - 1 s - ® :: b
O et s - [l :
0w | .- < T * e a0 4§
¢ .:'%__ -3 ‘: = 290
=_ g 0%
> m, & b, iy % e At
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Contact Information

This chapter contains the following topics:
e Contacting IBM Rational Software Support
e Prerequisites
e Submitting problems

e Other information

Contacting IBM
Rational Software
Support
If the self-help resources have not provided a resolution to your problem, you

can contact IBM Rational Software Support for assistance in resolving product
issues.

Note: If you are a heritage Telelogic customer, you can go to
http://support.telelogic.com/toolbar and download the IBM Rational
Telelogic Software Support browser toolbar. This toolbar helps
simplify the transition to the IBM Rational Telelogic product online
resources. Also, a single reference site for all IBM Rational Telelogic
support resources is located at
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have
an active Passport Advantage® software maintenance agreement. Passport
Advantage is the IBM comprehensive software licensing and software
maintenance (product upgrades and technical support) offering. You can
enroll online in Passport Advantage from
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html.

o To learn more about Passport Advantage, visit the Passport Advantage
FAQs at
http://www.ibm.com/software/lotus/passportadvantage/brochures fags
guickguides.html.

o For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational
Software Support, you must additionally:

o Be a registered user on the IBM Rational Software Support Web site. For
details about registering, go to http://www-
01.ibm.com/software/support/.

34|
© Copyright IBM Corp. 2004, 2009


http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/

o Be listed as an authorized caller in the service request tool.

Submitting
Problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a
problem to IBM, you are asked to supply a severity level. Therefore, you
need to understand and assess the business impact of the problem that
you are reporting.

Use the following table to determine the severity level.

Severity

Description

The problem has a critical business
impact: You are unable to use the
program, resulting in a critical
impact on operations. This condition
requires an immediate solution.

This problem has a significant
business impact: The program is
usable, but it is severely limited.

The problem has some business
impact: The program is usable, but
less significant features (not critical
to operations) are unavailable.

The problem has minimal business
impact: The problem causes little
impact on operations or a
reasonable circumvention to the
problem was implemented.

2. Describe your problem and gather background information, When
describing a problem to IBM, be as specific as possible. Include all

relevant background information so that IBM Rational Software Support
specialists can help you solve the problem efficiently. To save time, know

the answers to these questions:

o What software versions were you running when the problem

occurred?

To determine the exact product name and version, use the option
applicable to you:

o Start the IBM Installation Manager and select File > View
Installed Packages. Expand a package group and select a
package to see the package name and version number.

o Start your product, and click Help > About to see the offering

name and version number.

o What is your operating system and version number (including any
service packs or patches)?

© Copyright IBM Corp. 2004, 2009
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o Do you have logs, traces, and messages that are related to the
problem symptoms?

o Can you recreate the problem? If so, what steps do you perform
to recreate the problem?

o Did you make any changes to the system? For example, did you
make changes to the hardware, operating system, networking
software, or other system components?

o Are you currently using a workaround for the problem? If so, be
prepared to describe the workaround when you report the
problem.

3. Submit your problem to IBM Rational Software Support. You can submit
your problem to IBM Rational Software Support in the following ways:

o Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational/support/ and in the Rational
support task navigator, click Open Service Request. Select the
electronic problem reporting tool, and open a Problem Management
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support
Assistant. For more information, go to_http://www-
01.ibm.com/software/support/isa/fag.html.

o By phone: For the phone number to call in your country or region,
go to the IBM directory of worldwide contacts at
http://www.ibm.com/planetwide/ and click the name of your country
or geographic region.

o Through your IBM Representative: If you cannot access IBM
Rational Software Support online or by phone, contact your IBM
Representative. If necessary, your IBM Representative can open a
service request for you. You can find complete contact information for
each country at http://www.ibm.com/planetwide/.

If the problem you submit is for a software defect or for missing or inaccurate documentation,
IBM Rational Software Support creates an Authorized Program Analysis Report (APAR). The
APAR describes the problem in detail. Whenever possible, IBM Rational Software Support
provides a workaround that you can implement until the APAR is resolved and a fix is
delivered. IBM publishes resolved APARs on the IBM Rational Software Support Web site daily,
so that other users who experience the same problem can benefit from the same resolution.

Other

Information
For Rational software product news, events, and other information, visit
the IBM Rational Software Web site on_
http://www.ibm.com/software/rational/.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer
the products, services, or features discussed in this document in other countries. Consult your
local IBM representative for information on the products and services currently available in your
area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be used
instead. However, it is the user's responsibility to evaluate and verify the operation of any non-
IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You
can send written license inquiries to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM
Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any

other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions.
Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of
the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for convenience only and do
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites
are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i)
the exchange of information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been exchanged, should
contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street

Cambridge, Massachusetts 02142

U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some
cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore,
the results obtained in other operating environments may vary significantly. Some measurements
may have been made on development-level systems and there is no guarantee that these
measurements will be the same on generally available systems. Furthermore, some
measurements may have been estimated through extrapolation. Actual results may vary. Users of
this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products
and cannot confirm the accuracy of performance, compatibility or any other claims related to non-
IBM products. Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business operations. To
illustrate them as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental. If you are viewing
this information softcopy, the photographs and color illustrations may not appear.
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Trademarks

IBM, the IBM logo, ibm.com, DOORS, Passport Advantage, and Rational are trademarks or
registered trademarks of International Business Machines Corp., registered in many jurisdictions
worldwide. Other product and service names might be trademarks of IBM or other companies. A
current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel
Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel
Corporation or its subsidiaries in the United States and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation
in the United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.
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